
 

Microsoft Dynamics® GP
Export Financial Data



Copyright Copyright © 2012 Microsoft Corporation. All rights reserved.

Complying with all applicable copyright laws is the responsibility of the user. Without limiting the 
rights under copyright, no part of this document may be reproduced, stored in or introduced into 
a retrieval system, or transmitted in any form or by any means (electronic, mechanical, 
photocopying, recording, or otherwise), or for any purpose, without the express written 
permission of Microsoft Corporation. Notwithstanding the foregoing, the licensee of the software 
with which this document was provided may make a reasonable number of copies of this 
document solely for internal use.

Trademarks Microsoft and Microsoft Dynamics are trademarks of the Microsoft group of companies. FairCom 
and c-tree Plus are trademarks of FairCom Corporation and are registered in the United States 
and other countries.

All other trademarks are property of their respective owners.

Unless otherwise noted, the companies, organizations, products, domain names, e-mail 
addresses, logos, people, places, and events depicted herein are fictitious. No association with 
any real company, organization, product, domain name, e-mail address, logo, person, place, or 
event is intended or should be inferred.

Intellectual property Microsoft may have patents, patent applications, trademarks, copyrights, or other intellectual 
property rights covering subject matter in this document. Except as expressly provided in any 
written license agreement from Microsoft, the furnishing of this document does not give you any 
license to these patents, trademarks, copyrights, or other intellectual property.

Warranty disclaimer Microsoft Corporation disclaims any warranty regarding the sample code contained in this 
documentation, including the warranties of merchantability and fitness for a particular purpose.

Limitation of liability The content of this document is furnished for informational use only, is subject to change without 
notice, and should not be construed as a commitment by Microsoft Corporation. Microsoft 
Corporation assumes no responsibility or liability for any errors or inaccuracies that may appear 
in this manual. Neither Microsoft Corporation nor anyone else who has been involved in the 
creation, production or delivery of this documentation shall be liable for any indirect, incidental, 
special, exemplary or consequential damages, including but not limited to any loss of anticipated 
profit or benefits, resulting from the use of this documentation or sample code.

License agreement Use of this product is covered by a license agreement provided with the software product. If you 
have any questions, please call the Microsoft Dynamics GP Customer Assistance Department at 
800-456-0025 (in the U.S. or Canada) or +1-701-281-6500.

Publication date November 2012



E X P O R T  F I N A N C I A L  D A T A i

Contents

Introduction .................................................................................................................................................1
What’s in this manual...................................................................................................................................1

Symbols and conventions ............................................................................................................................1

Resources available from the Help menu..................................................................................................2

Send us your documentation comments ...................................................................................................4

Chapter 1: Report ................................................................................................................................. 5
Export file overview .....................................................................................................................................5

Selecting and exporting the balance file ....................................................................................................5

Selecting an account range ..........................................................................................................................6

Index .......................................................................................................................................................................9



ii E X P O R T  F I N A N C I A L  D A T A



E X P O R T  F I N A N C I A L  D A T A 1

Introduction
Export Financial Data allows you to export the ACCON account balance report for 
Belgium and ETAFI account balance report for France to a format that can be 
imported by the legal authorities of Belgium and France.

Check for current instructions
This information was current as of November 2012. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics® GP 
online Web site (http://go.microsoft.com/fwlink/?LinkID=249465) for the most 
current documentation.

This introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an understanding of how to use the features of 
Export Financial Data, and how it integrates with the Microsoft Dynamics GP 
system.

To make best use of Export Financial Data, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

The manual is divided into the following chapters:

• Chapter 1, “Report,” describes how to export the ACCON and ETAFI account 
balance reports for the specified criteria.

Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

http://go.microsoft.com/fwlink/?LinkID=249465
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This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you 
select an option, the process to install the updates will begin immediately.

Check with your system administrator before installing tax updates. To be sure that tax 
updates are installed correctly, refer to documentation for specific tax updates on the 
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Report
Use this information to select the account range and specify the period for which to 
export the ACCON or the ETAFI account balance reports. 

You must select BE or FR as the country code in the Company Setup window 
(Administration >> Setup >> Company >> Company) to export the ACCON 
account balance report for Belgium and the ETAFI account balance report for 
France.

This information is divided into the following sections:

• Export file overview
• Selecting and exporting the balance file
• Selecting an account range

Export file overview

Use the ETAFI export file to export financial data required by the French legal 
authorities. The ETAFI export file contains the ETAFI account number, the account 
description, the beginning net change balance, sum of the debit amounts for all 
periods excluding beginning balance, sum of the credit amount for all periods 
excluding beginning balance and the total period balance of the year for the 
specified account range.

Use the ACCON export file to export financial data required by the Belgium legal 
authorities. The ACCON export file contains the ACCON account no., the total 
debit amount for all the periods including beginning balance and the total credit 
amount including beginning balance of the year for the specified account range.

Selecting and exporting the balance file

Use the Export Financial Data window to export the selected balance file for a 
specific year and to a specified location. The fields in the window change 
depending on the file you choose to export.

To select and export the balance file:
1. Open the Export Financial Data window.

(Reports >> Financial >> Export Financial Data)

2. Select the year for which to export the balance file.

3. Select whether to export the financial data for the ACCON (BE) or for the ETAFI 
(FR) report.
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4. Mark the Open Files option if you have selected to export the ETAFI balance 
report for an open year.

5. Choose the file name and the location to export the ACCON or the ETAFI 
Accounts balances report in the File Name field. The default file names are 
ACCONBAL.CED for the ACCON balance file and ETAFIBAL.CED for ETAFI 
balance file respectively.

6. Choose ACCON Account Range to select the range of accounts for the ACCON 
balance report. Refer to Selecting an account range on page 6 for more 
information. This button is available if you have selected ACCON (BE) as the 
Export Financial Data option.

7. Choose ETAFI Account Range to select the range of accounts for the ETAFI 
accounts balances report. Refer to Selecting an account range on page 6 for more 
information. This button is available if you have selected ETAFI (FR) as the 
Export Financial Data option.

8. Choose Export to export the balance information for the selected accounts to the 
specified file.

9. Choose OK to close the window.

Selecting an account range

Use the Export Account Range window to select the account range to include in the 
selected report. You can select multiple account ranges in this window. The window 
name depends upon the export financial data option selected in the Export 
Financial Data window.

To select an account range:
1. Open the Export Account Range window.

(Reports >> Financial >> Export Financial Data >> Select ETAFI (FR) as the 
Export Financial Data option >> ETAFI Account Range) OR
(Reports >> Financial >> Export Financial Data >> Select ACCON (BE) as the 
Export Financial Data option >> ACCON Account Range)

2. Select the range in the Account From and Account To columns.
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3. Enter a name for the account range. This is the name that appears at the 
beginning of each range in the report.

4. Chose OK to return to the Export Financial Data window.
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